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Welcome to the Alaska Exotic Plant Management Team! This document will guide you through
this summer’s field season, including collecting data using Trimble GPS units and a customized
Data Dictionary, data management, collecting specimens, taking photographs, and more. Since
the same protocol is used throughout the Alaska Region of the NPS, it is intended to maintain
high standards of quality in data and consistency among observers. If you have any questions
about what is written here, please do not hesitate to contact liaison Jeff Heys (907-644-3451,
Jeff Heys@nps.gov) or data manager Whitney Rapp (907-697-2603, Whitney Rapp@nps.gov).

The protocol itself is a GPS-based method to map exotic plant infestations and uninfested areas
and collect relevant information about them. The data will become part of a database that spans
multiple years from across the Alaska Region of the NPS. It will also be incorporated into a
statewide database that has been developed to track exotic plant distributions across
jurisdictional boundaries.

Starting the Season

Establish Park Priorities for Season

What are you going to do this summer?
Where are you going to go?

What areas need to be revisited?

What new areas need to be inventoried?
What are the control priorities?

First, read all the annual field reports for your park whether you are returning or new to the
program. The insights from previous years will be invaluable to establishing priorities for this
season. Consult with Jeff Heys for a regional perspective and your park supervisor and/or
resource division for a local perspective. Remember that plant phenology will dictate some of
your work. In other cases, travel logistics may limit access to areas of the park. Undoubtedly,
there will always be more that could have been done, but with a solid set of priorities, you will
accomplish a significant amount this summer.

Regional priorities for 2008 include:
= Increase the number of photos taken, particularly of people working in the field, invasive
species in unexpected places, species invading natural areas, and new species.
= Collect herbarium specimens of all species not previously collected.

As a regionwide priority, map all species with a ranking greater than 50 (Table 1) at a higher
precision than you might otherwise since we need to have more precise information on
distribution and extent of infestations for planning alternative, non-manual treatments.
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Table 1 — Species of greatest threat to Alaska. Species in bold are already known to occur in or near
Alaskan National Park Units. All of the following species should be mapped and treated with the highest
level of precision. Ranking from http://akweeds.uaa.alaska.edu/akweeds ranking_page.htm 4/10/08.

Scientific Name(s) Common Name(s) Rank
Eolygonym_sachallnen_se, Fallopia sachallnensm, giant knotweed, Bohemian knotweed,

.X bohemicum [cuspidatum x sachalinense], F. 87

. . . . Japanese knotweed

X bohemica, P. cuspidatum, F. japonica
Centaurea biebersteinii spotted knapweed 86
Lythrum salicaria, L. virgatum purple loosestrife, spike loostrife 84
Phalaris arundinacea reed canarygrass, canarygrass 83
Impatiens glandulifera ornamental jewelweed 82
Melilotus alba white sweetclover 80
Nymphaea odorata ssp. odorata white waterlilly 80
Hieracium aurantiacum and Hieracium orange hawksweed, devil's paintbrush 79
caespitosum & meadow hawkweed
Bromus tectorum cheatgrass 78
Rubus discolor Himalyan blackberry 77
Cirsium arvense Canada thistle 76
Prunus padus European bird cherry 74
Vicia cracca bird vetch, cow vetch, tufted vetch 73
Alliara petiolata garlic mustard 70
Cytisus scoparius English broom, Scotch broom 69
Linaria vulgaris yellow toadflax, butter and eggs 69
Caragana arborescens Siberian pea shrub 66
Lonicera tatarica bush honeysuckle 66
Melilotus officinalis yellow sweetclover, king's crown 65
Campanula rapunculoides Creeping bellflower 64
Medicago sativa ssp. falcata Yellow alfalfa 64
Hordeum jubatum foxtail barley 63
Senecio jacobaea ragwort, stinking willie 63
Bromus inermis ssp. inermis smooth brome 62
Cirsium vulgare bull thistle, common thistle 61
Leucanthemum vulgare oxeye daisy, white daisy 61
Sonchus arvensis L. ssp. uliginosus perennial sowthistle, moist sowthistle 61
Hordeum murinum ssp. leporinum leporinum barley, lepor barley 60
Elymus repens quackgrass, couchgrass, dog grass 59
Medicago sativa ssp. sativa Alfalfa 59
Sorbus aucuparia European mountain ash, rowan 59
Trifolium repens white clover, ladino clover 59
Convulvulus arvensis field bindweed, morning glory 58
Taraxacum officinale common dandelion 58
Gypsophila paniculata baby's breath 57
Tanacetum vulgare common tansy, garden tansy 57
Trifolium hybridum alsike clover 57
Phleum pratense common timothy 56
Crepis tectorum narrow-leaf hawk's beard 54
Dactylis glomerata orchardgrass 54
Ranunculus repens, Ranunculis acris creeping buttercup and tall buttercup 54
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Stellaria media at sea bird colonies common chickweed 54
Trifolium pratense red clover 53
Vicia villosa winter vetch 53
Hypericum perforatum St. Johnswort 52
Poa pratensis ssp. pratensis, P. pratensis ssp. Kentucky bluegrass, spreading 59
irrigata, P. trivalis bluegrass and rough bluegrass

Verbascum thapsus common mullein 52
Digitalis purpurea purple foxglove 51
Rumex acetosella sheep sorrel 51
Fallopia convolvulus (Polygonum convolvulus) black bindweed 50
Tagopogon dubius yellow salsify, goat's bear 50

General File Management

In an effort to organize data that works well for each team and future users of the files, a

suggested file structure is described.

1.

In collaboration with your supervisor or IT staff, identify the appropriate place to
store your data at your park that is accessible by you, secure, and routinely backed up.
This may be on your local machine (C:\) or on a network drive. It is best to co-locate
data for 2008 with previous data.

Relocate the past year(s) folder or create a folder (such as EPMT_(park code)) in this
location that will contain ALL of your data, documents, etc. Within this folder, tiers
of subfolders can be created.

The suggested file structure is depicted in Fig. 1 with each balloon representing a
folder. This is definitely not exhaustive of the possibilities, but it is a framework to
organize files, is adaptable for many years, and will be useful for others.

In the root folder, create an index document (index.doc or Project_Organizer.doc) in
Word that directs people to the various files within the folders. Using hyperlinks will
further facilitate others to find relevant information quickly.

At the end of the season, make 2 copies of the entire folder to CD or DVD. Label the
CD/DVD with EPMT, Park Code, and year. Send one copy to the regional office and
store another at your park.

*** All GPS data must be edited and uploaded to the regional drive by the end of every pay
period (every 2 weeks). This will ensure that the data is being processed correctly and timely
on your part and that Jeff/\Whitney can process it into the national and statewide databases and
make the data available for your use.
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Figure 1 — Suggested file management structure for storing electronic files at your park. Please
remember to copy all files to regional drive and/or to CD/DVD at end of season.
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Setting up Trimble GPS Units

This protocol does not provide instructions on the operation of Trimble GPS units. The Alaska
EPMT will be using primarily Trimble GeoXT receivers and TerraSync 3.20 and Pathfinder
Office 4.10 software. More detailed protocols on GPS operation should be addressed through
Trimble training provided by Joel Cusick (907-644-3549). Reviewing his training binder may be
helpful. In addition, many GPS solutions are posted on the regional GPS web pages -
http://inpakroms03web/rgr/gps/tips.htm and
http://inpakroms03web/rgr/akgis/index.cfm?action=dsp&topic=gps&item=gps. Finally, these
TerraSync guides provide good information — Getting Started Guide and Quick Start Guide.

With that, let’s jJump right into the EPMT GPS protocol that lies at the heart of our data
collection using the Trimble GPS.

GPS Housekeeping at Start of Season

What legacy data will you be carrying around with you this season? None, if you do the proper
housekeeping! This will speed up your unit and ensure plenty of storage space.
1. Using PFO, download all the rover files to a backup folder and notify your park’s GIS
personnel or past users of file locations.
2. In Windows Explorer with your unit connected to the computer, select the Mobile Device
from My Computer.

File  Edit Miew Favorites Tools  Help

W Eac! <) I? /_—1 Search || Folders v

Address »j Py Compuker

= _ Mame

System Tasks __" _$31_,.~’2 Flappy (A:)

2L DVD Drive (D)

g1 i i

14 Add or remove programs i?:EGT;ZD:;:D(E?j

[} iZhange & setting ’_‘-_grﬂaintenance on 'npsiakrdfsiclbal Teams' (H:)
A Elnterpretation on 'npsiakrdfsiGlbal Teams' (3:)

‘éﬁScience an 'npsiakrdfsialba’ (K0

Other Places fx.ﬁ.dministratiun on 'npsiakrdfsiGlbal Teams' (L)

..-ESvstem on 'npsiakrdfsiclba’ (r:

EF‘rutectiun on 'npstakrdfsiGlbal Teams' (P

EFiles on 'npsiakrdfsialba’ (G0
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System Folder Q Mobile Device
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u‘:] My Documents

Details
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3. Navigate to \Disk\My Documents\TerraSync (most likely location), copy all files to a
backup folder on your computer, then delete them from your GPS. Look into other
folders as well.

Backup your GPS unit (Start>Backup Now).

In TS on the GPS, use the File Manager (Data>File Manager) to delete all previous data
that is no longer needed. For example, old rover files, data dictionaries, backgrounds,
etc. Some background files may still be useable if made for a similar area or purpose.
6. Backup your GPS again.

S

GPS Software

= TerraSync (TS) is the software that operates on your GPS. The current version v3.20 is
available from Trimble. You will need your TerraSync serial number to upgrade. To run
this version, you must also upgrade to Pathfinder Office v4.10.

= Pathfinder Office (PFO) is the software that operates on your computer to process your GPS
data. The current version v4.10 is available from Trimble. You will need your Pathfinder
Office installation code (serial number) to upgrade.

= ActiveSync is the software that enables your computer to communicate with your GPS. For
computers running Windows XP, the current version 4.5 is available online.

Let Jeff/Whitney know if you are working with older software versions since settings may be
different! It is best to uninstall previous versions and install new versions. Depending on your
user settings for computer use, you may require an IT specialist to facilitate the software
installations.

GPS Transfers

To have the GPS communicate with the computer, you must have Microsoft ActiveSync
installed on the computer. Once ActiveSync is installed, the GPS cradle is connected to the
computer, and the GPS (already on) is placed in the cradle, the GPS should connect to the
computer. If you have problems, try restarting the computer, reconnecting the GPS, and
reconnecting the cradle. If you still have problems, try contacting one of us.

GPS Settings

Files must be initially transferred to the Trimble unit using the Data Transfer utility in Pathfinder
Office. They are located in the GPS_Settings folder in 2008 OUTGOING. Never transfer
Trimble associated files using Explorer or any other means than the Data Transfer utility.
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Transfer the following files to the GPS:

1.

3.

Configuration file (GeoXT2003Summer_08_TerraSync.tcf or
GeoXHwithZephyrSummer_08_TerraSync.tcf) following the instructions in the
associated word file. If you get an error on the GPS, you are likely not running the
current version of TerraSync. For GPS receivers not using TerraSync, contact us.
Data Dictionary file (08_ AKEPMT _master.ddf) after you have arranged the fields for
your own convenience using the Data Dictionary editor utility in Pathfinder Office.
a. Do not remove or add attribute values or data fields.

b. Arrange the order of attribute values using the up and down arrows so that the
ones you use most commonly are at the top of each list. For example, your
initials and your park’s locations.

c. Set the values that you use for most records as defaults if desired.

d. Any field you alter as described above must be altered in all feature classes
(Pnt2Buf, Line2Buf, Poly, etc). An easy way to do this is by copying the data
field you’ve altered (ctrl+c), then pasting it into the other feature classes (ctrl+v),
and then deleting the duplicate unaltered field it replaces (Delete key).

e. Save the modified file with your initials (e.g., 08_ AKEPMT_JAH.ddf).

f. Load this modified data dictionary onto your GPS unit. If possible, only use one
data dictionary during the season.

Data files ([number]_[species code]_08.imp) of data from previous years.

Set time zone:

SurwnE

Go to the “Start” menu of the Trimble unit

Tap on “Settings”

On the “System” tab, tap on “Clock”

Verify that the time zone is set to “GMT-9 Alaska” and tap OK.

Is the time right after the unit has been outside and received satellite information?
Due to the recent changes in Daylight Savings Time, Mobile 2003 units and newer
have patches to correct for the time of year shifts. See Joel Cusick’s bulletin on

updating time.

To standardize our Trimble units for data collection, we are using a configuration file that sets
the most important GPS settings to predetermined values.

1.

2.
3.
4

o u

Open up TerraSync on the unit (tap F1)

Select “Setup” from the main menu.

Below the “Current Configuration:” box, tap on the box labeled “Change”

Select “GeoXT2003Summer_08_ TerraSync” or otherwise from the menu and tap on
“Load”

Tap on the “Logging Settings” box from the “Setup” screen.

By default, the antenna height is 1.5m. Click on the wrench icon and change the
height to your own chest height. You should hold the GPS at this height to collect
data. You can enter a height in feet (enter a value “4.25 ft”) and it will automatically
convert to meters (“1.295 m”).

Still in *“Logging Settings,” change the “Filename Prefix” (default *‘R’) to the first
letter of your last name.
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GPS Background Images

Having a background file display on your GPS or in PFO can be very helpful to navigate to a
new location or verify that data is correctly recorded. To get a background image to display, you
must create a jpg file in ArcGIS, transfer the file, and verify the coordinate systems of the GPS.

1.

2.

IS

oo

10.
11.
12.

13.
14.

15.
16.
17.

Make a map in ArcGIS. Some helpful information may include a background photo,
USGS topographic maps, NOAA charts, previous data, park boundaries, trails, etc.
Record what the map coordinate system is by double clicking on the “Layers” icon in
the right navigation window. Look at the “Coordinate System” tab. The map should
be in a projected coordinate system (Alaska_Albers_Equal_Area_Conic or

NAD 1983 UTM_Zone 8N). Be aware that regional data was converted from
NAD27 to NAD83 in 2006.

Once the data is arranged as you would like it and the screen has the map extent that
you want (zoom in and out to export what is visible in the window), select “Export
Map” from the “File” menu.

Experiment with different resolutions and qualities. Having a background image will
slow down GPS map drawing, so you need to balance between speed and image
quality. The higher the resolution and quality, the slower the image will redraw.
Since map drawing is affected by how large the map is, you may want to create
several smaller maps for different study areas so the GPS has less to redraw at any
one time.

Check the “Write World File” option and save the map. Adding the resolution to the
end of the file name will help remind you of what files are larger and smaller.

Open PFO (testing the image in PFO will save you much anguish with the GPS).
Select “Coordinate System” in the “Options” window. Define the coordinate system
to match the exported map. This is only changing how the data is displayed, not how
it is collected or saved. See Table 2 for the correct settings based on the projection of
your image. If these options aren’t showing up, you probably do not have the most
current version of coordinate system software. To fix, close PFO. Go to C:\Program
Files\Common Files\Trimble\GeoData and backup current.csd (make a copy and
paste in same folder). Then delete the file current.psd. Re-launch PFO, and it should
rebuild the file and provide the needed options.

Make sure “Coordinate Units” is in meters and hit “OK.”

Load the background in PFO by selecting “Background” from the “File” menu. Click
“Add” and navigate to the image.

Change the coordinate system to match the coordinates you just established for PFO.
Select “OK” and the image should load.

Verify the image is correctly positioned by opening a data file (.ssf or .cor) and verify
that the features align with the image.

Connect your GPS to the computer.

Using PFO, transfer the image to the GPS using the “Send” tab and “Add”ing a
“Background.”

On the GPS, go to “Setup” in TerraSync.

Change the “Coordinate System” to match those defined in PFO (Table 2).

Go to “Map” and under “Layers” select “Background File.” Choose the correct file.
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Table 2 — Coordinate settings required for Albers or UTM (KLGO, GLBA, SITK) for use in ArcGIS,
Pathfinder Office, and TerraSync.

Albers (All other AK parks)

UTM (KLGO, GLBA, and SITK)

ArcGIS Alaska Albers Equal Area Conic (using NAD83) NAD 1983 UTM Zone 8N
. n B
Coordinate Data Frame Properties Data Frame Properties
System
Annotation Groups ] Eutent Rectangles Annotation Groups ] Estent Rectangle:
General ] DataFrame  Coordinate Spstem ] General ] DataFrame  Coordinate Syster
Current coordinate system: Current coordinate syskem:
Alaska albers_Equal_aArea Conic MaD_1983 UTM_Zone 8N
Projection: albers Projection: Transverse_Mercator
False_Easking: 0,000000 False_Easting: S00000,000000
False_Morthing: 0000000 False_Morthing: 0.000000
Central_Meridian: -154. 000000 Central_Meridian: -135,000000
Standard_Parallel_1: 55.000000 Scale_Fackor: 0,993600
Standard_Parallel_2: 65,000000 Lghtude_QF_Ongm: 0.000000
Latitude_OFf_Crigin; 50,000000 Linear Unit: Meter
Lineat Unit: Meter
GCS_Morkh_American_1953
5ICS_Morth_American_1983 Daturn: D_Morth_American_1983
Daturn: D_Morth_American_1983
Select a coordinate system! Select a coordinate system:
(1 Favorites |;| Favorites
# {1 Predefined +-] Predefined
#- ] Lavyers +-] Layers
= a <cuskom:= = ‘-‘3 <cuskon >
i . UTM_Zaone &M
Pathfinder Coordinate System @ Coordinate System
Office
. Select By oK Select By oK
* Coordinate Sygtem and Zone e " Coordinate Spstem and Zone T
System 2 7
Help Help
System 115 Continental =l -3 Sgstem Ty =l e |
Zone: | NP 3] Zonet | g Nath -
Datum:  MAD 1983 [Conug) CORS9E Datunm: INAD 1983 (Corus) CORS 95 ﬂ
Altibude Measured From Altitude Measured From
" Height Abowe Elipzoid [HAE) " Height Above Elipsoid (HAE)
+ Mean Sea Level [M5SL) (v }
Geoid Model Geoid Madel
&+ Defined Geoid [REDIDO3 (&laska]] ¢ Defined Geoid (EGMIE (Global))
" Other (« Other
| ! =l Geoid: [GEQIDOZ [Alaskal -l
Coordinate Urits; |Me[e[3 ﬂ Coordinate Units; |Meters j
Altitude: Lnits: |Melers ﬂ Altitude Units: |Meters ﬂ
TerraSync System: US Continental System: UTM
Coordinate Zone: Alaska Albers83 (CORS 96) Zone: 8 North
System Datum: NAD 1983 (Conus) CORS96 Datum: NAD 1983 (Conus) CORS96

Altitude Reference: Mean Sea Level (MSL)
Altitude Units: Meters
Geoid Model: Other
Geoid: DMA 10x10 (Global)
Coordinate Units: Meters
Display USNG: Off

Altitude Reference: Mean Sea Level (MSL)
Altitude Units: Meters
Geoid Model: Other
Geoid: DMA 10x10 (Global)
Coordinate Units: Meters
Display USNG: Off
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18. Under “Layers”, make sure the “Background” option is checked. Image should
display and you won’t get an error if all the coordinate systems were properly
assigned.

Collecting GPS Data

When you walk up to an infestation of exotic plants, the first question to ask yourself is: can this
patch be best represented as a point, a line, or a polygon? Because all patches take up 2-
dimensional space, they are all actually polygons. Using GPS units to map exact polygons takes
more time, so we sometimes save time by mapping them as points or lines and using a “buffer
distance” that the plants extend from the point or line.

In addition to mapping infestations, you should map areas with no exotic species to document
that you looked and for future monitoring. This is critical baseline data since the absence of
exotics is as valuable as the presence of exotics. Use the “none” or “0” option for the data fields
to record the absence of exotic plants.

Points

= Use points on a very small patch of plants in a circular shape. Use a “buffer distance”
representing the radius of the circle to capture the size of the patch.

Lines

= Use a line to represent a long string of plants along a roadside, shoreline, or similar edge.
Apply a “buffer distance” equal to half the width of the linear patch and walk the midline
of the patch.

Polygons

= Actual polygons are best used to map large or irregular shapes that are not well-
represented by points or lines. They should be used to map most infestations of species
ranked greater that 50 by the Alaska Natural Heritage Program, in order to provide
sufficient precision to be able to document short-term changes in patch shape.

Data Dictionary Fields

The standardized data dictionary has fields that help systematically describe plant populations
throughout the state.
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Table 3 — Description of data dictionary fields used to map exotic plant infestations (Pnt2Buf,
Line2Buf, and Poly).

Location_Name

This is the general area where the activity takes place with several possible in
each park unit. For a description of each area, see the LocationID table below.
Note that a single LocationID must either be inside or outside of the park
boundary; pay careful attention to this in choosing the appropriate one. You
should certainly arrange these in the order of your most common usage.

Disturbance_Type

Because most of Alaska’s exotic plants grow only on disturbed sites, we are
tracking what disturbance types are being invaded by what species in NPS units.
The options are listed in the Disturbance Type table below. The most frequently
applicable type is fill importation, which includes roadsides and construction
sites.

Site_Description

The location description is an opportunity for you to delineate in words the exact
location, as well as any information about that location that might be important.
The first provision should enable someone who looks at a table of your data to
understand where within the LocationID the work took place without having to
use GIS. Take the time while editing to be complete and also try to be concise.
The second provision should note if there is special significance in the location,
such as remoteness, proximity to a stream or river, or potential to be easily
spread into other areas.

Buffer_Distance_ M

This is the buffer distance in meters that will be used to convert points and lines
into polygons. If you imagine the shape you will be creating, the buffer distance
should extend the point or line to the boundary of the infestation at its maximum
distance from the center point or line. The buffer distance will therefore be half
the width of a linear shape or the radius of a circle around a point. The GPS unit
can also offset a line so that you may walk the edge of a linear infestation, offset
the line to the middle of the infestation, and assign a buffer distance according to
its width. The buffer for uninfested roads and trails should generally be 5
meters, measured from the centerline of a trail or the barren edge of a road.

Taxon

This is the dominant exotic plant species of a particular infestation. All species
that have been reported from Alaska NPS units are on this list. If the species of
concern does not appear on the list or you are uncertain of its identity, enter
“Other” and note the species or uncertainty in the Remarks field. If the mapped
area is free of exotic plants, enter “None”. Remember to record species ranked
greater than 50 precisely rather than as part of another species’ infestation.

Phenology

The dominant phenology at the time of the exotic species is especially important
for control timing and future planning. “rosette” is for plants that are still young
and have not reached their full size. “no_flower” is for plants that are full size,
but they are not currently flowering or producing seed. “full_flower” are plants
that are currently flowering. “in_seed” are plants that are currently producing
seed. “stand_dead” are plants that are standing dead.(standing dead). If there
are no exotics present, enter “none”. If you are monitoring a location for a
species and it is not redetected, put the name of the species being searched
for in Taxon and select “not_detected” in phenology. This will allow us to
better track eradications. You can clarify in the comments if the species has
multiple phenologies.

%_Cover

The cover class percentage of the dominant exotic species is a critical measure of
an infestation’s density. Imagine yourself suspended directly above the polygon
you are mapping, including the buffer applied to points and lines. The value you
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enter is the percentage of the entire area that is covered from this angle by the
material of the exotic species, with options of 1, 5, 10, 20, 30, 40, 50, 60, 70, 80,
90, 95, and 100. This is much easier to do with small areas than with large ones,
so start by practicing with small patches and be conservative with your estimates
(i.e., do not overestimate). Note that there is a correlation between this value and
the buffer distance or size of a polygon: as the buffer distance increases for a
particular group of plants, their percent cover of the total area decreases. Do not
worry if most of the time the value entered is 1, for this is common with the non-
woody, disperse plant populations we are dealing with. It is most important to
accurately record the extent and density of an infestation.

Stem_Count This is a stem count of the dominant exotic species. Only enter a value when
you are certain that you can provide a relatively accurate count of individual
plants. If the action is a control event, this is much easier to ensure, for each
person involved can count the number of plants he or she controls. If the action
is not a control event, do not record a value over 100 unless you have carefully
counted the plants. You will find during control that there are almost always
more plants than you saw at first. 1f you don’t count the plants, leave the field
with the default, -9, which indicates no plants counted. A zero should only be
used if there are no plants.

Action “Inventory” is the first documentation of a particular infestation, whereas
“Monitor” is a follow-up visit to a previously inventoried site from this year or
previous years. “Treatment” is the first control effort for a particular infestation
and “Retreatment” applies to any subsequent control efforts in either the same or
successive years. “Manual” involves pulling or digging. “Mechanical” involves
actions like mowing, weed-whacking, chain-sawing, etc. “Chemical” involves
the use of herbicides.

% _ Treated Percentage of area treated — 0, 1-25%, 26-50%, 51-75%, 76-95%, 96-100%.
Make notes in comment field what was/wasn’t treated. For example, removed
all flowering plants or many seedlings left.

CntrlEffrt For planning and evaluation, it is helpful to have a relative indicator of the
control effort required for a particular infestation. This can be projected if the
infestation is not controlled or actual if it is. To standardize, “low” refers to an
infestation that could be manually controlled by one person in less than an hour.
“Medium” infestations could be controlled by one person in less than an 8-hr.
day. “High” infestations would require multiple people or multiple days to
control.

Is_Exhaustive If all the exotic plants encountered were recorded, enter “yes.” If only a subset
of species are recorded, enter “no.” In general, you should record all species;
however, if you are trying to map a particular species very accurately, you may
want to use this option to ignore other species.

Comments This is a free-for-all for you to convey anything that seems important about an
infestation or uninfested area, such as: control might not work for a particular
reason; species’ identity is uncertain or not listed in the species list; components
of the native plant community; potential for spread if left untreated; data
collection is incomplete; where to look if hidden; invading undisturbed plant
community; apparent source of infestation; similar native species in the same
area; need for monitoring, etc. You are free to use shorthand as long as you are
sure of your own language, but it must be made intelligible upon editing! Use all
lower case for consistency except for proper names.

Park_Unit Associated park is the four-letter code for whatever park unit you’re working in,

AK EPMT Protocol 2008 - 13



which should be set as the default value.

Is_Inside_Park

If the area mapped is located on park land, enter “yes”; if it lies outside of the
park boundary or on inholdings, enter “no”.

Recorder_Name

These are the initials of the person using the Trimble unit. Set your initials as the
default value.

Team_Name

If you are performing the activity in question alone or with help, enter
“AKEPMT”. If you are recording the accomplishment of volunteers, enter
“Volunteer”, or of other NPS personnel, enter “Other”.

2Taxon, 3Taxon...

2Phenology,
3Phenology...

2% Cover,
3% _ Cover...

2StemCount,
3StemCount...

2Action, 3Action...

2Control_Effort,
3Control_Effort...

We have provided additional fields for 9 more exotic species other than the
dominant species at a particular site. In general, we prefer that you record each
species individually with its own shape rather than use these additional fields.
This option is provided to save you time when there is a whole complement of
species infesting the same area and you don’t have time to map them
individually. Remember that if the extents of each species are not the same, this
option should not be used. For each additional species, you must also enter the
phenology, percent cover, stem count, action, and control effort (see above)
using additional fields provided.

StartDate,
StartTime

Don’t worry about these fields, because the unit creates them automatically for
each feature recorded.

Table 4 — Description of generalized locations for field Location_Name.

Ejar::: LocationID Location Description InPark
BELA | serpentine_springs tSheerlc()aentme Hot Springs and ATV trails radiating out from yes
CAKR | dmts_rd road from Red Dog Mine to port yes
CAKR | kakagrak_hills abandoned military base and airstrip yes
CAKR | kotzebue Kotzebue and surroundings no

park road from the entrance at the Parks Highway to
DENA | first_mile headquarters, including headquarters, housing, sled dog area, yes
etc
DENA | kantishna inholdings at the end of the park road after Wonder Lake yes
DENA | mckinley_village development along Parks Highway outside the boundary no
DENA | nenana_river banks of the Nenana River no
DENA | park rd park road between headquarters and Kantishna yes
DENA | parks_hwy Parks Highway along boundary no
DENA | railroad along railroad tracks, near depot, including airstrip yes
GAAR | kuyuktuvuk Kuyuktuvuk watershed, including Oolah Pass yes
GAAR | noatak Noatak watershed yes
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GLBA | bartlett_cove frontcountry Glacier Bay, including lodge yes
GLBA | beardslees Beardslee Islands yes
GLBA | dry bay Dry Bay and vicinity yes
GLBA | dundas_bay Dundas Bay and surrounding areas yes
GLBA | east_arm coastline of the East Arm of Glacier Bay yes
GLBA | glacier_bay_other Othe_r areas of park not in Dry Bay, Dundas Bay, or main yes
Glacier Bay
GLBA | gustavus Gustavus and surroundings no
GLBA | main_bay the portion of Glacier Bay to the south of the two arms yes
GLBA | west_arm coastline of the West Arm of Glacier Bay yes
KATM | 10000 _smokes rd entire road leading to the valley of 10000 smokes yes
KATM | brooks_camp brooks camp and surrounding area yes
KATM | katm_outer_coast anywhere along the katmai coastline yes
KATM | king_salmon King Salmon and surroundings no
KATM | lake _camp entire lake camp road, boat ramp area, and parking area yes
KEFJ | exit_glacier Exit Glacier Road and associated development and trails yes
KEFJ | kefj_outer_coast anywhere along the Kenai Fjords coastline yes
KEFJ | seward Seward and surroundings no
KLGO | chilkoot_trail the Chilkoot Trail Unit yes
KLGO | dyea Dyea and surroundings yes
KLGO | dyea road Road to Dyea and surrounding area not in park no
KLGO | skagway Skagway and surroundings no
KLGO | white pass the White Pass Unit yes
LACL | lacl_outer coast anywhere along the outer coast of LACL yes
LACL | port_alsworth_nps | NPS headquarters in port alsworth and surrounding areas yes
LACL | port_alsworth_town | town of port alsworth and surrounding areas no
LACL | twin_lakes anywhere around twin lakes yes
NOAT | noatak Noatak watershed yes
SITK | sitka Sitka and surroundings no
SITK | sitka park Sitka National Historic Park yes
WRST | chitina Chitina and surroundings no
WRST | copper_center Copper Center and surroundings no
WRST | edgerton_highway gL?t?Q: New Edgerton Highway from Richardson Highway to no
WRST | glenallen Glenallen and Glenn Highway no
WRST | kennicott Kenmcott (Town and Mine Site), Bonanza Ridge and Root yes
Glacier Trails
WRST | may_creek NPS compound, airstrip, and surrounding roads and trails yes
WRST | mccarthy McCarthy and surroundings yes
WRST | mccarthy rd tr;e;gillgn from Copper River bridge to Kennicott River plus ATV yes
WRST | nabesna rd Nabesna Road and ATV trails yes
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Peavine, Huberts, Tana, Jake's, C-N confluence, Chisana so

WRST | remote_airstrip far yes
. . Richardson Highway from Gakona Junction (north) to

WRST | richardson_highway Edgerton Highway (south) , except for Copper Center no

WRST | slana area outside of the park at the entrance to the Nabesna Road no

WRST | tok_cut_off along Tok Cut-off from Slana to Gakona Junction no

WRST | viscenter headquarters and visitor center complex yes

YUCH | coal creek coal creek camp and surrounding areas yes

other DESCRIBE THE LOCATION IN THE COMMENTS

== NPS Theme Manager

Theme Listz }Eavurite&] ﬁearch]

E [x:] Albers-Metwork

[ Alaska-wide Themes

[ All Subsistence Themes

[ Anchorage Themes

[ ANIA Themes

[ BELA Themes

[} CAKR Themes

[ Canada Themes

[ DEM

[ DENA Themes

[ ESRI Data Themes

{3 Exotic Plant Management
] By Park

= Plant Surveys

P

[] GAAR Themes
[ GLBA Themes

Ty W ATRL TL

Figure 3 — Location of the GIS layer that

To visually see the delineation of each
LocationID, refer to the “EPMT Location

Index” theme in ArcGIS that can be loaded

using NPS Theme Manager (Fig. 3).

delineates and describes Location_Name fields.

Table 5 — Description of the disturbance types for field Disturbance_Type.

Disturbance Type Disturbance Description

ABDHOME Abandoned Homesite

ANIMAL Animal Related Disturbed Site
BRSHCUT Mechanical Brush/Tree Cutting
COASTAL Coastal/Beach

FLIMPRT Fill Importation (e.g. Road or Railroad)
GLACIER Glaciation

GRAZING Grazing

HRBCIDE Herbicide Application

LOGGING Logging
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MATEXTR Material Extraction (e.g. Quarry)
MINING Mining
MOWING Mowing
ORVDST ORV Disturbance
OTHER Other Mechanical Substrate Alteration
PLOWING Plowing
RIVER River Action
SLIDE Landslide/Avalanche
STREAM Stream Action
THERMAL Thermal Disturbance
TRMPLNG Trampling
VOLCANO Volcanic Action
WIND Wind Disturbance/Erosion
WLDFIRE Wildfire
WNDTHRW Windthrow
NONE No Disturbance

General Tips for Using the GPS

= While recording a feature, hold the unit head-high and away from your body, so that it
can “see” more sky.
= The logging interval (how often the unit records a position within a feature) has been set
in the data dictionary to one second for points and five seconds for lines and polygons.
This is the desired interval; however, when satellite availability is marginal the 5 seconds
may be too long to collect sufficient points. In this situation, temporarily change the
logging interval to 1 second
1. While in the Data view (because you’re collecting a feature) tap “Options”
2. Select “Logging Interval” and change the “Logging Interval” to “1s”
3. When good satellite coverage resumes, readjust the interval to “5s”
= We recommend recording at least 15 positions for points and enough positions for lines
and polygons to delineate the shape (more around corners and curves, fewer for straight
sections).
= For the integrity of the data, it is a good idea to begin a new rover file every few hours
rather than using the same one all day. Also, make sure each event (different location,
different crew, etc) is in a separate rover file.
= Remember that you can always press “Pause” to stop the recording of positions
temporarily while the feature is still open. This is helpful if you have to maneuver
around an object, but you do not want to map your deviation.
= Stopping and resuming a feature. If you are mapping a large area with multiple common
species (such as a long road) and suddenly stumble upon an unusual species, you should
map the unusual species more accurately then lumping it into the larger polygon. In this
case, stop the existing feature, map the specific feature, then resume the original feature.
= |f the new feature will be a point (including photo point or collection),
then use the “Nest” option:
1. Pause the feature you have been collecting.
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Within the data screen, select “Options” > “Nest” > and select
appropriate feature type.

Record the new feature.

When you are complete and hit OK, you will return to the feature that
you originally paused.

= |If the new feature will be a line or polygon, then stop, map the new one,

and resume:

1. In TerraSync, stop the current feature by clicking “OK.”

2. Map the new feature.

3. To resume the original feature, in the menu where you usually pick the
feature type, switch “Collect” to “Update Features.”

4. Select the feature you want to resume. It is probably the second
closest distance, and you will be able to see the comment along the
bottom of the screen.

5. Click “Begin” followed by “Log.”

6. Select “Continue Feature (Append)” to continue adding points to the
original feature.

7. End the feature like normal.

8. To collect a new feature, you will need to change “Update” back to
“Collect.”

9. You will only be able to update recent features, so do not map multiple

new features and plan to return to the original feature.

= Turn on/off sounds when collecting positions

1. On the Start Menu tap on “Settings”

2. On the “Personal” tab, select “Sounds and Notifications”

3. On the “Volume” tab, check “Programs” and “Notifications” and adjust the
volume bar.

= Offset feature. In general, you should map the boundaries with buffer as exactly as
possible; however, sometimes you will be unable to map an edge because of satellite
coverage (e.g., under trees, next to a building) or physical barriers (e.g. river, fallen
trees). In these cases, you can map a set distance from the target and set the offset and
direction. The offset applies to the whole feature, so plan ahead!

1. With the feature already open, select “Offset” from the “Options” menu.

2. For aline or polygon, the direction is the direction the target is from you as you
walk the segment. The horizontal distance is the distance that you are from the
target edge.

3. For a point, you have 5 options: Distance-Bearing, Distance-Distance, Triple
Distance, Bearing-Bearing, Triple Bearing. See this QuickStart file for more
information.

Monitoring

All control sites from previous years should be monitored and retreated this summer. The
reason for this is that we are in the beginning stages of exotic plant management in Alaska’s NPS
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units, and we need to know what is working and what is not. Beyond this, it is generally
recommended for any exotic plant control that the site be monitored into the future, because
there may still be a seedbank in the soil or plants may resprout. For control sites where there are
exotic plants present upon return, control the site again and plan to return within a month or so to
evaluate the effectiveness.

Loading Data Files

All previous year’s data has been transformed into species specific data files (example
01_BROINE_08.imp) for use on the GPS units. Once transferred to your GPS unit using PFO,
the data files can be used in one of two ways

Data file as background

As a background, the polygons are visible on the “Map” screen, and you can collect features in a
rover file, but the attribute information of the data file is not accessible. You can load multiple
background files, which would allow a background image plus several taxa.
= Within TerraSync, select “Map” screen. From the “Layers” menu, select “Background
Files.” Make sure the “Show Data Files” is selected. Select the data file(s) to display.
= The polygons are now loaded as a background image.
= None of the attribute information is accessible, but you can navigate to the polygons and
collect features in a rover file.

Data file as existing data file

When the data file is loaded as an “Existing Data File”, the polygons are visible on the “Map”
screen, and you can view the attribute information, but you can not collect new features or open
other rover files.
= Within TerraSync, select “Data” and “Existing.”
= Highlight the appropriate taxon data file and select the “Open” button.
= The data file is now open like a rover file, but you should not collect new features.
= Under “Options” in either “Data” or “Map,” you can “Filter” the data. For example, you
could filter by park or by management action. The filtered polygons will display as
green.
= From the “Data” screen you can see the distance to the nearest polygons.
= Any polygon’s attributes can be opened by highlighting it in the “Data” screen and
selecting “Begin.” From the “Map” screen, you can select a polygon using the “Select”
arrow from the upper left menu. This will display the summary labels. By selecting
“Update Selected Feature” from the “Options” menu, you can then see all of the
polygon’s attributes. Do not log positions since this would change the data!!!
= To collect new features, you must return to the “Data” screen, “Close” the data file, and
reopen a rover file or begin a new rover file.
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Navigating to Previously Recorded Polygons

Particularly when treating and monitoring previously documented sites, it is important to be able
to relocate a site. Using the “Map” screen is generally much easier than using the “Navigation”
screen.

Using Map screen

With a data file loaded as either a background or existing data file, you will see the polygons
relative to your position. As you walk, your trail will display, and you will be able to modify
your path to get to your target. If this is not enough, you can set “Nav Start” and “Nav Target”
through the “Options” menu. “Nav Start” should be “GPS,” which is your current position (a
single flag will appear). Click on the screen where you want to go and then select “Nav Target”
as “Map Point” (two crossed flags will appear). The blue line connecting these two locations is
the direct path. Under “Options”, selecting “Cross-Track Light Bar” will display a bar at the top
of a map that will indicate the relative direction you need to go to get to the target.

Alternatively, you can set the “Nav Target” to the polygon desired if the data file has been
opened in the Data screen. By selecting the polygon, under “Options” you can then set the target
as either the “Start/End” or generally better the “Centroid.”

Using Navigation screen

Set the “Nav Start” and “Nav Target” as described above. The “Navigation” screen will display
a number of variables of your position relative to the target, including distance, heading, bearing,
etc. that are selectable by you. The cross-track bar will display on the top as well to show
relative direction of travel needed. The central circle also shows the desired path. Holding the
GPS in front of you, the arrow within the circle points in the desired direction. You need to be
moving for the GPS to provide directional information.

Restoration

For parks engaged in restoration activities, a polygon feature should be collected to record the
total number of person hours, what native species were added, and in what form the native plants
were. Additional fields for a revisit date and description of care/maintenance and survival rate
are included, but they may be easier filled in after the fact in PFO.

Table 6 — Description of attributes within feature Restoration.

Location_Name This is the general area where the activity takes place with several possible in
each park unit. For a description of each area, see the LocationID table (Table 4).
Note that a single LocationID must either be inside or outside of the park
boundary; pay careful attention to this in choosing the appropriate one. You
should certainly arrange these in the order of your most common usage.

Disturbance_Type | Because most of Alaska’s exotic plants grow only on disturbed sites, we are
tracking what disturbance types are being invaded by what species in NPS units.
The options are listed in the Disturbance Type table (Table 5). The most
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frequently applicable type is fill importation, which includes roadsides and
construction sites.

Site_Description The location description is an opportunity for you to delineate in words the exact
location, as well as any information about that location that might be important.
The first provision should enable someone who looks at a table of your data to
understand where within the LocationID the work took place without having to
use GIS. Take the time while editing to be complete and also try to be concise.
The second provision should note if there is special significance in the location,
such as remoteness, proximity to a stream or river, or potential to be easily spread
into other areas.

Comments This is a free-for-all for you to convey anything that seems important about a
restoration, such as purpose, what exotic species you are trying to prevent,
suggested maintenance or additional restoration, etc. use all lower case for
consistency except for proper names.

Park_Unit Associated park is the four-letter code for whatever park unit you’re working in,
which should be set as the default value.
Is_Inside_Park If the area mapped is located on park land, enter “yes”; if it lies outside of the

park boundary or on inholdings, enter “no”.

Recorder_Name These are the initials of the person using the Trimble unit. Set your initials as the
default value.

Team_Name If you are performing the activity in question alone or with help, enter
“AKEPMT?”. If you are recording the accomplishment of volunteers, enter
“Volunteer”, or of other NPS personnel, enter “Other”.

Hours This is the total person hours (number of people multiplied by the number of
hours) that were spent restoring the area.

Native_taxon A text field to record the scientific name of the native species used during
restoration.

# Planted Number of individuals planted. If seeds, describe the volume or weight and
clarify in the comments.

Type Form of the native plant. This is a list including cutting, fruit, individual,

rhizome, runner, seed, seedling, stem, and transplant.

2Native_taxon, 3 | Additional fields for 4 more native species used during restoration.
Native_taxon ...

2# Planted,
3# Planted ...

2Type, 3Type...

Revisit_Date Date of site revisit. This field is most likely to be filled out in the office using
PFO after the initial polygon feature collection.

Care_Maintenance | Description of any care or maintenance that occurred at the site after the initial
restoration. This field is most likely to be filled out in the office using PFO after
the initial polygon feature collection.

Survival_Rate Description of the survival rate of the native plants added to the restoration area.
This field is most likely to be filled out in the office using PFO after the initial
polygon feature collection.
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Processing GPS Files in PFO

All GPS data that you collect this summer will be processed using Pathfinder Office (PFO)
software, Trimble’s desktop data management software. At the beginning of the season, make
sure the software is updated and that it will continually update by selecting the option in the help
menu (Fig. 4). Depending on your park’s computer settings, you may not be able to
automatically update software. Talk to your local IT staff for assistance.

inder Office

Data Utiities Options  Window Nglls]

Contents. ..
Search For Help on...
How ko use Help, ..

Check Far new GP3S Pathfinder Office updates now...
v Automatically check for GPS Pathfinder Office updates

Regiskration
Trirmble on the Wweb 3

About GPS Pathfinder Office. ..

Figure 4 — Enable Pathfinder Office to automatically update by
selecting the option in the “Help” menu.

Setting up a Project

=

Open GPS Pathfinder Office (PFO).

2. The first time you download GPS files for the season, create a new project for your
park by selecting “New”

3. Give the “Project Name” the title “2008_EPMT _(park code)” and browse to the

...\Data\GPS\2008 folder for the “Project Folder.”
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Cornrnent:

— Diefault folder for—

Project Marme: ] 20050513

Monday, Map 18, 2005 4:20:34 pm

Project Folders

Project Folder:
st e Project Mame: | 2005_EPMT_GLBA
E:Z:’;“Z:f: Comment.  [wednesday, May 03, 2006 34337 pm
| Proiect Falder: ]_Species\F‘lants'\Data'\GF‘S'\2DDE| Bronwze, .
1 Backup Folder: Back B
v Dizplay thiz dialo ] = M
Export Folder: |E>:|:n:rt Browse...
Base File Folder: ]BaSE Broneer
0K l Cancel | Default | Help ]
4. Select “OK”
5. Click “Yes” when it asks, “Folder already exists Do you want to continue?”
6. Creating the new project creates 3 new folders within ...\Data\GPS\2008 — Backup,
Base, and Export.
7. In Explorer, create one more folder (Final_Edits) within the project folder.
8. For the rest of the season, select the project name from the drop down menu that

appears in the “Select Project” screen.

Transferring Rover Files

1. Transfer your rover files (.ssf) from the GPS unit to this folder as soon as possible

after data collection.

2. In PFO, select “Utilities” > “Data Transfer”
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:E" Data Transfer

Device

]GIS D atalogaer on wWindows CE LJ E]]E:Q E []EQ‘ Devices... J

Feceive lSend ]

Filez to Receive

File Size Data Type | Destination

Settings... I Help ‘ Cloze I

Make sure the device is “GIS Datalogger on Windows CE”

The GPS should connect (status in upper right) automatically or when you click the
button with the green circle with check mark.

Click “Add” and “Data File”

Select all the files needing to be transferred.

Click “Transfer All.”

Back up your rover files immediately in the project Backup folder.

> w

N oo

Differentially Correcting Rover Files

1. In PFO, select “Differential Correction” from “Utilities.”

2. Add the file that needs to be corrected. To get the quality control values for the rover
log spreadsheet, you need to process files individually.

3. Verify the differential correction settings.
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fferential Correction Wizard

~Processing Type —

(¥ {Aukomatic Carrier and Code Processing;

[ Code Processing Qnly

[ Zarrier Processing Cnly

< Back | Mext = |

Cancel ] Help ‘

Correction Settings

Settings ]Dutputi Base |

i~ Code Processing Technique

7 With welocity filtering

— GPS Filtering-
© se data collection filker settings

" Use new fiker settings:

dd

[ Comect velocity records W Re-comect realtime positions

x]

Ok Cancel

:

Help
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Correction Settings
Settings  Dutput ]Base ]

- Output Pazitions

" Comected and Uncorected

i~ Audit File Contents—
" Mone
¢ Standard
" Expanded

Settings] Output  Base l

Baze Data Processing Technigue
{v i

T With filtering and smoothing

Baze Data Filtering -

tinimurn Elevation: o -

Minimum SMR[DEHz]:  [p T ]

o]

Cancel 4l Help
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Differential Correction Wizard

—icorrect Settings

Standard rover processing
Rover Filkering with data collection settings
Do not correct velocity records

Re-correct real-time positions

Standard audit files

Standard base processing

< Back I Mext = | Zancel Help

4. Select a base station. Generally, you want to select the closest base station to where
the data was collected. Sometimes you may have to select a different base station.
Update the base provider list periodically by selecting “Update List.”

Select Base Provider

Provider Diskance J Integrity Index ] ~
R CORs, Gustavus, AK 11 km = B
E CORS, Gustavus Ak 11 km 91.47
E CoORS, Juneau, A 76 km 90,58
E CCRS, Biorka Island Ak 179 km 89,63
F. sorac, whitehorse, daily 256 km 89.75
E CORS, Level Islandl Ak 277 km 86,85
. Base Mapping & Geomatic Services, Dease Lake 341 km ?
Show Inteqrity Index of Type: ICnde :_I
Show Base Providers of Twpe: ]p‘" types _:J

[~ Base Provider -

Help oK I Cancel
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5. Do not change any of the base station information or reference positions.

ifferential Correction Wizard [;h: El

| Base Data

(* Base Provider Search

] CORS, Gustavus AK Select. .,

=

" Folder Search

" Browse

i~ Reference Position
(" Use reference position from base Files

{* Lse reference position From base provider
CORS, Guskavus Ak Select, ..

¥ Confirm base data and position before processing:

< Back | Mext = | Zancel ‘ Help I

ifferential Correction Wizard [;h: El

1~ Cutput Folder

" Use the project Folder

@ |se the same Folder as the input file

-utput Filename -

™ Create a unigue filename based on the input Ffilename

{* 1se original filename, overwriting any existing .cor file.;

< Back | Skark; | Zancel ‘ Help I

6. Correct files by clicking “Start”

7. Assuming good differential correction (ideally over 90%), fill out rover file status log
using values that appear at the end of differential correction or that are saved in a text
file in the project folder.
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8.

Back up your .cor files immediately by copying them into the project Backup folder.

Editing Files

In order to ensure high data quality, review and edit every rover file within a few days of the data

collection.

1.

10.

11.
12.

Copy your corrected files from the project folder into the “Final_Edits” folder and
add the prefix “edited_” to each file name. For example, R051015A.cor becomes
edited_R051015A.cor. Copying and renaming the file before editing ensures that you
do not overwrite the original corrected file when you begin editing.

Check the validity of positions, once differentially corrected, to make sure they match
what you recorded in the field. Using a background image will help with this.

For point features, click “Delete” in the Feature Properties window to see that the
positions are reasonable. The “Delete” does not delete your positions but it gets rid of
the feature grouping the positions. Points should have all of their positions clustered
together. You may need to delete whacky points (using the “Delete” in the “Position
Properties” window), such as points more than a few meters from the center of a
point. Once the feature looks good, you should click “Undelete” in the “Feature
Properties” window to regroup the positions.

For a line or polygon, you will need to delete positions that double back or cause
loops in the feature. Generally the positions with the highest value in “Horiz.
Precision” should be deleted since they have the most likely error.

Document position deletions in the rover log.

If a feature was recorded as the wrong type (e.g. line collected as point), follow this
protocol for correcting or contact Whitney for assistance.

Review the attributes attached to each features to check that the information is
accurate and complete.

Elaborate on location descriptions or comments and eliminate any bad data. If you
wrote in shorthand only understandable by you, now is the time to convert it to
complete thoughts! Your comments will be viewable by the public, so make them
understandable and appropriate for ALL AUDIENCES. Species can be abbreviated
by using the first three letters of the genus and species. For example, Leucanthemum
vulgare would be leuvul.

Take the necessary time to make your data as finished as possible. These files will be
transformed into GIS data at the end of the season for anyone to peruse. Did you
leave any fields blank? Are all the attributes correct?

In the project folder, maintain a status spreadsheet park_rover file status_2008.xls
(save the spreadsheet locally with your park code as a prefix) to keep track of which
files still need to be edited. List any issues, deletions, deviations from the protocol, or
field notes you had for each rover file.

Copy the Final_Edits files into the project Backup folder.

Periodically burn a CD of or otherwise backup the project folder and upload all raw,
corrected, and edited rover files (.ssf, .cor, and edited.cor) and log to the

2008 _INCOMING folder at the end of every pay period.
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13. Once you have finished editing a file, you are done with it until the end of the season.
14.  Once all edited files are complete, let us know and we will transform them into GIS
files to ensure consistency among park units and send them back to you for your

reference in preparing the seasonal report.

Whitney’s Editing Strategy — I think it’s most efficient to first look at the shapes of all the
features and do the necessary deletions of positions to make the shapes true to life. 1’ll do this
for the entire cor file. | then start at the beginning again and quickly flip through the features
looking at the attributes for blank data fields (yes, even | sometimes forget to populate a
field). I populate the field if I can accurately recall what it should have been. | then start at
the beginning for the last time to carefully review the attribute information, replace any
shorthand, and otherwise clarify comments. This strategy works for me to assure the spatial

and attribute data get the attention they both need.

Historic EPMT Data

This protocol does not describe how to use ArcGIS;
however, it does describe how to review all historic
EPMT data for the entire region. From NPS
ThemeManager (Fig. 5), load either all of the regional
data (Exotic Plant Management > Plant Surveys >
EPMT Exotic Plant Surveys) or park specific data
(Exotic Plant Management > By Park > (Park Code)
Exotic Plant Surveys) by dragging the name into
ArcMap. Information about the polygons can be found
using “Identify” or selecting the polygons and looking
at the “Attribute Table.” Note: the themes may not
work in earlier versions of ArcMap, so upgrade to
ArcGIS 9.2.

Time LoqQ

All of our data must be entered into a nationwide NPS
database (APCAM - the Alien Plant Control and
Monitoring database) that requires very specific
information about the amount of time spent and people
involved in every activity we perform, not only in the
field but also in the office.

To ensure consistency between all the parks, Jeff and/or

Whitney will be doing all the data entry in APCAM.
Realize that this is a major burden that you will not
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have to bear. In order for this to happen, however, we will require very specific information on
the time you spend on individual activities on a daily basis from the moment you read this
protocol until the last day you work for the EPMT in 2008. We know that this seems extreme,
but there is no other way to satisfy the database requirements and minimize database angst.

1.

2.
3.

o

~

Copy the spreadsheet park_time_record 2008.xls to your local folder and change
“park” to your park’s acronym.

At the end of each day, make a log of what happened.

All work time activities should be accounted for, including:

=  Administrative Tasks = Misc Park Activities

=  APCAM data entry = NEPA related

= Budget/Finance = Partnership development
= Control Work = Personnel Management
= Data Collection = Prepare for training/travel
= Data Management = Presentation Preparation
= Education & Outreach Activities » Project Planning

= Equipment Maint/Repair = Report Writing

= Formal Meetings Attended = Restoration

=  GIS/GPS Work = Time Lost Due to Injury
= Hiring Activities = Training

= Meeting =  Travel

If the activity is associated with a GPS rover file, record those file(s) in your time log.
Each person routinely associated with the EPMT should account for their activities on
an individual line. So, even if Whitney and Jeff are both controlling oxeye daisies
from 10:00 to 12:00, there should be two lines with each of their initials. If people
not usually associated with EPMT work are assisting, they can be accounted for them
in the “Number of other people” field and then describe who they are in the
description.

Locations, initials, etc can be modified by adding/deleting values from the “Pull-
down menus” worksheet.

All grey fields will automatically calculate. Do not modify the formulas.

As with all important files, back this one up on a regular basis.
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Table 7 - An example of a 1-day trip in GLBA with two EPMT staff and another NPS employee. The
fields shaded gray are automatically calculated.

Number | Number
Day Rover File EPMT | of other of Number Total
of Time | Time | Activity Activity Associated | Weight| Person| NPS |voluntee| of other | Total People
Week| Date Start | End | Category | Location | Park |Description with Activity |  (Ib) Initials | staff rs people | People | Hours | Hours
Prep & Prepare for field
Mon | 6/2/2008 | 8:00 | 10:00| Cleanup Office | GLBA |work WSR 1 2 2.00 | 4.00
Skiff to Strawberry|
Mon | 6/2/2008 | 10:00| 11:00] Travel Travel | GLBA |Island WSR 1 2 1.00 2.00
Control control perennial
Mon | 6/2/2008 | 11:00 | 15:30 Work main_bay | GLBA |sowthistle R060215a 35 WSR 1 2 4.50 | 9.00
Mon | 6/2/2008 | 15:30| 16:30] Travel Travel | GLBA |Returnto BC WSR 1 2 1.00 | 2.00
Prep & Prepare for field
Mon | 6/2/2008 | 9:00 | 10:00| Cleanup Office | GLBA |work JAH 1 1.00 | 1.00
Skiff to Strawberry|
Mon | 6/2/2008 | 10:00| 11:00] Travel Travel | GLBA|lIsland JAH 1 1.00 | 1.00
Control control perennial
Mon | 6/2/2008 | 11:00| 15:30] Work main_bay | GLBA |sowthistle JAH 1 4.50 | 4.50
Mon | 6/2/2008 | 15:30| 16:30] Travel Travel | GLBA |Returnto BC JAH 1 1.00 | 1.00
Prep &
Mon | 6/2/2008 | 16:30| 17:00| Cleanup Office | GLBA |clean-up field gear| JAH 1 0.50 | 0.50

Photo Management

*** All photo data must be edited and uploaded to the regional drive by the end of every
pay period (every 2 weeks). This will ensure that the data is being processed correctly and
timely on your part and that Jeff/Whitney can process it into the national databases and make the
data available for use.

Photos are an excellent tool for exotic plant management, not only to document infestations and
sites for our own internal purposes, but also to convey to others what we are dealing with and

what we have accomplished. Several excellent photo opportunities include:
Before and after photos of infestations that are controlled
Volunteer events — work in action
New or uncertain species, range expansions, or particularly nasty infestations

Close-ups of particular species to aid in identification

Restored plant communities
Educational events
Yourselves and others working with exotic plants

You should be taking photos essentially everytime you are outside! That said, we can only
use these photos later on if we keep them organized and collect relevant information about them.

Taking Photos

Use the GPS “Photo_pt” feature that will later be coupled with GPS-Photo Link by Whitney to
bring the photo together with the position and attribute information.
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Before taking photos:
= Set the camera’s clock to be as close to the GPS clock as possible (8 hours less than UTC
time during AK daylight savings). Recheck at least monthly!!!
= Resolution should be as high as reasonable given memory constraints, with the preferred
filesize (for a .jpg) being greater than 1 MB per photo.
= Before you take your first picture of the
day, take a picture of your GPS screen
showing the time with seconds. This is
critical for the GPS-Photo Link software.
Within TerraSync Status>UTC Time
(Fig. 6) has the time. Verify the image is
legible. Several photos are better than
one that is unclear. Be aware that the
screen is very reflective and not easy to
take a good picture of clearly. Holding
the GPS at an arms length or using the
macro (flower) setting when the GPS is
closer may also improve the focus.

When taking photos:
= Before you take the photo, collect a

Figure 6 — Screen shot of GeoXT showing “Photo_Pt” feature using your Trimble
UTC time with seconds. Alaska daylight unit at the spot where you are standing
savings time is 8 hours less. This screen is when taking the photo.

essential for linking to the photo time for GPS-

Photo Link.

Table 8 — Description of attributes within Photo_Pt feature on GPS.

Photographer Initials from drop down menu

Location_Name Standard locations from drop down menu

Comments Short description/title of image. Such as “Visitor Center dandelions.” This
description will later be watermarked onto the image with GPS-Photo Link.

Internal Longer description/comment. Such as, “Area will be treated next week.” This

comment will be embedded in attributes and not displayed on image. Record more
specific location/event information here. This is what will give lasting value to the

image!
LookDir Direction you are facing to take the image.
Filename Record image number/file name. This may be feasible in the field or easier to do as

you edit images in PFO.
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= After the Photo_Pt is collected, then take your photo(s) of the same scene. If the subject
of the photo changes such that your description is no longer valid or your position
changes, you need to record a new Photo_Pt before taking the next photo.

Managing Photos

We recommend that you manage your photos — meaning upload, organize, and delete useless
photos — at the same time that you are editing your spatial data in Pathfinder Office.

= Maintain subfolders by event, such as 20080613 Weed_Pull, that will help you and us
locate a photo.

= Step through the “Photo_pt” features in Pathfinder Office with an image browser window
open at the same time and ensure that the attribute information is complete. If
incomplete, modify the attributes to be accurate. Ensure that the image name is in the
Filename field.

= Delete any photos that are unusable — blurry, too dark/light, etc.

= |f there are images that do not have Photo_Pt features, modify the filename by putting a
“z” at the beginning of the filename to flag us not to link it to a position.

= Always keep the original, unmodified, unedited images. DO NOT rotate, resize,
brighten, or darken any original photo since you risk losing all data collection time
embedded in the photo. If you want to edit an image, resave it with another name, such
as [original filename]_edited.

= At the end of every pay period, transfer all photos you have to the regional drive.

= Whitney will process the photos using GPS-PhotoLink and the data collected with your
Trimble, such as the example (Fig. 7)
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GLBA EPMT 2007 IMGP0224_042007_100228 no exotics on snow

N 58.45611° W 135.86765° NAD 83 7m 04/20/2007 10:02:28 AM

Figure 7 — How an image taken after a Photo_Pt can be combined in GPS-
Photo Link to incorporate the position and field comment. A shapefile is also
aenerated that contains the additional attribute information.

Voucher Specimens

What to Collect

In order to back up our observations of plants in the field, voucher specimens should be collected
under certain circumstances:

. Any species previously unrecorded in a park unit must be collected.
. Any species that you cannot positively identify must be collected.
. Any species with a significant range expansion or found in remote areas should be

collected, with priority given to species of greater concern.

In 2008, make an effort to fully collect all specimens previously reported but not collected.
Refer to the table AK_EPMT_Master_Exotics.xls for a list of all the species reported for each
park with a column for when the plant was collected. Data for collection years before 2005 were
taken from the 1&M database NPSpecies and may need verification with your park herbarium.

AK EPMT Protocol 2008 - 35



Let Whitney Rapp know of any changes needed to this spreadsheet. Verify that you have the
necessary permission to collect within your park.

How to Collect

1) A photo should be taken of the whole plant prior to collection following the photo protocol.
2) A GPS “Specimen_Pt” should be recorded to account for as many fields as possible.

Specimen_Pt fields on GPS

Collection Date

Date specimen collected

Collector Name

Initials of collector

Taxon

Scientific name of species if known

Park_Unit

Park abbreviation

Location Name

Standard locations from each park

Specific_Locality

Field to make more specific description of location

Habitat

Field to make more specific habitat description

Soil_Texture clay, silt, sand, loam, gravel, or other — see table below for descriptions
Soil_Moisture dry, moist, wet, or other

Exposure N, NE, E, SE, S, SW, W, NW

Slope_Site flat, gentle, steep, other

Species_Abundance rare, infrequent, common, abundant, other

Assoc_Spp Field to enter other nearby native and non-native species

Notes Any additional notes or clarification on fields

Photographed? Yes/No — All specimens SHOULD be photographed

Collnum *Collection number. Initials followed by number. e.g. WSR001
Photo_filename *Filename of specimen photo

Determiner *Person who identified the specimen

Determiner_Date

*Date determiner identified the specimen

NPS_Accession

*NPS accession number

NPS_Catalog

*NPS catalog number

Native

*Nativity of specimen — Yes, No, or Unk

Collection_number

*1dentifying number of specimen (initials followed by number)

* these fields are likely best populated in the office in PFO.

3) Collect the specimen. All parts of the plant should be represented, including roots and

flowers or fruits, and should be preserved using a plant press or heavy books with newspaper.
Each species should be dried within newspaper and labeled with the information below or a
unique collection number (initials followed by a number — WSR001, WSR002) that relates
back to the master table.

Review the University of Alaska Museum’s collection recommendations
(http://www.uaf.edu/museum/collections/herb/projects/reports/instructions-for-plant-co/).

Information about the specimen collected should be recorded in the spreadsheet (park
ID) Collections 2008.xls. It may not be feasible to record all fields, but an effort should be
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made to populate as many fields as possible. Fields in bold in the table below are required. Use
the “Specimen_Pt” data collected on your GPS.

Collnum

Initials followed by number. e.g. WSR001

Park

Four letter park acronym. e.g. GLBA, DENA

Scientific Name

Best identification possible. AKNHP will verify all identifications and modify as
necessary.

General Locality

General location of specimen. e.g. Parks Highway or Bartlett Cove.

Specific Locality

Specific location of specimen. e.g. 1.5 miles from park boundary on east side of
road.

Lat (DD) Latitude in decimal degrees. e.g. 59.68595

Long (DD) Longitude in decimal degrees. e.g. -135.56987

GPS/Map Source of lat/long - from GPS or calculated from map.

Map Datum Map datum used for lat/ long (NAD27, 83 etc).

Elev Elevation of collection.

Elev unit ftorm

Habitat Describe habitat. e.g. roadside, coastal meadow, riparian, spruce forest

Soil Texture Soil texture. Clay = smallest particle size (<3.9 um — not gritty in your mouth); a
marble-sized hunk rolled between your fingers will form a ball. Silt = small
particles (3.9-62.5 pum — will feel gritty in mouth); a marble-sized hunk rolled
between your fingers may form a ball. Sand = larger particle size (0.0625 mm -2
mm); a marble-sized hunk rolled between your fingers will not form a ball. Loam
= relatively even concentration of sand, silt, and clay; a marble-sized hunk rolled
between your fingers will seem to form a ball, but it will fall apart once pressure
is released. Gravel = largest particles (2-75 mm)

Soil Moisture Soil moisture (wet, moist, dy, other)

Exposure Which way the site faces (N, S, E, W, etc)

Slope Angle of site (flat, gentle, steep)

Abundance Relative abundance of species at location (abundant, common, infrequent, rare)

Assoc. spp. Other native or non-native species growing in the area.

Collector(s)

Enter as: Heys, J.
Enter multiple collectors separated by commas with “&” before the last collector:
Heys, J. & Rapp, W.

Collection Date

full date (6/25/2006)

Determiner Person who identified specimen.
Det Date Date specimen was identified (9/27/2006).
Photo# Name of digital image or full path to image.

NPS Accession #

Generally, the entire set of specimens will receive the same accession number
from the park’s curator.

NPS Catalog #

Each specimen will get a unique number from the park’s curator. 1f 3 common
dandelions are collected, make 3 separate rows, each with its own catalog #.

Notes

Any other taxonomic or collection notes/comments, such as flower color (some
blossoms fade with drying, some colors intensify), odor, conspicuous use by
animals, specimen looks like a hybrid or doesn’t match descriptions, etc.

At the end of the season:

1. Obtain the accession number and catalog numbers from your park’s collections
curator.
2. Verify that each specimen is identified by at least its Collection Number.
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3. Send all specimens to Jeff Heys at the regional office with a print out of (park ID)_
Collections_2008.xls

4, Ensure the table (park ID)_Collections_2008.xls is transferred to your park’s
incoming folder within the regional folder.

Phenology Loqg

Throughout the season, record when exotic species first flower and first set seed using the
park_Phenology 2008.xls spreadsheet (save the spreadsheet locally with your park code as a
prefix). It may be easiest to print out the sheet and routinely write down the dates throughout the
season. Then, enter the information into the spreadsheet. If you visit several park areas
periodically that you suspect have different phenologies, record dates on separate sheets for these
different locations. Printing this spreadsheet on weather resistant paper and storing it in the GPS
pouch serves two purposes. Not only will you have it in the field to record dates, but if you
space out on the name of a species to record in the GPS, the sheet may trigger your memory
since it has common names!

Seasonal Report

The seasonal report for your park is your chance to summarize what you’ve learned and
accomplished with regard to exotic plant management. These are immensely valuable for
record-keeping and future planning, and it will also demonstrate to your supervisor the quality of
your work. There is no page limit for this, because it is more important that you get across what
you did and found this summer, no matter the length. Be as thorough as possible with this. Feel
free to borrow from previous years rather than recreating the wheel. The best reports build on
the information from previous years!

Items to be covered in the report:

= Abstract/Executive Summary — a succinct summary of the season that could include total
number of species inside/outside of park, areas surveyed, new species found, species
eradticated, acres inventoried/infested/treated, etc. This may be your only opportunity to
inform someone!

= Introduction - you do not need to provide an overview of why invasive plants are a
problem for Alaska. Instead, focus on your park unit's history of exotic plant surveys and
management efforts - the context of your work in 2008

= Methods - explain how you chose where to survey, where you surveyed, how
thoroughly/frequently you surveyed each area, and what control methods and personnel
you used, but don't go into detail about the data collection protocol (cite that you
followed this protocol).

= Results — this should be the focus of your report. Let the reader know what you found
and did, so that the data does not have to speak for itself. Include:
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. Accomplishments (Prevention, Detection, Inventory, Control, Monitoring,
Restoration, Education, Contacts, etc.) — use your time log to remind yourself
of all the activities you have been involved in

. Summarize 2008 exotic plant distribution (diversity and relative species
abundance in frontcountry and backcountry) in comparison to what you know
of results from previous years. Highlight any new species or situations of
particular concern. Are there eradicated populations? Are any species
colonizing natural areas? Let us know!

o Include a table that includes all the invasive species documented in and
around your park at any time. This should be the list from
AK_EPMT_Master Exotics_2008.xls and any additional species documented
in 2008. If there are species on our master list that you do not believe should
be there, let us know. Include in this table if you observed it in 2008 and what
parts of the park it was seen (e.g. Park Headquarters, Park Road, Backcountry,
Outside Park). If the species has been eradicated, include it in the list but
indicate that when it was last observed.

= Discussion and Recommendations - Make recommendations for next year to improve
how things can be done at your park or regionwide. Be thorough with everything that
could be done, even if it seems unlikely to happen. Also include anything else you think
is important! You've spent a summer working with and thinking about this issue, so offer
your perceptions, concerns, ideas, problems, etc.

Use the common and scientific names that appear in the master exotics table so that they are
consistent throughout your report and the region.

Maps are optional. If you would like to make maps in GIS with the 2008 data, let Whitney/Jeff
know by September 1 so the data can be transformed to a shapefile.

As far as timing goes, the data processing must be complete by Sept. 1 at the latest and
preferably earlier so that we can troubleshoot any problems or inconsistencies that arise.
Determine who at your park should review the document. Draft reports should be sent to Jeff
Heys at least two weeks prior to your end date or Sept. 15" (whichever is earlier) for review. If
that presents a problem, let us know. In any event, if you have any questions or issues, give us a
call or email.

Reports from all parks and years can be consulted for form and content to improve your report!

Thank you for your participation this summer!! Please give Jeff or Whitney any suggestions
about how we can improve this protocol and the program. We hope that you are interested in
continuing to work with the Alaska Exotic Plant Management Team in the future.
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Table 9 - Summary table of invasive species observed in and around Alaska NPS units through 2007. Red fields indicate the most

abundant or highest ranked species.

Created 5/13/08

Taxon

Aegopodium podagraria
Agrostis gigantea
Alopecurus geniculatus
Alopecurus pratensis
Amaranthus retroflexus
Arabis glabra

Arctium minus
Beckmannia syzigacene
Brassica rapa

Bromus inermis and similar
Capsella bursa-pastoris
Caragana arborescens
Centaurea montana
Cerastium fontanum and similar
Cerastium tomentosum
Chenopodium album
Cirsium arvense
Collomia linearis

Crepis tectorum

Dactylis glomerata
Descurainia sophia
Digitalis purpurea
Dodecatheon jeffreyi
Elymus repens

Erodium cicutarium
Erysimum cheiranthoides
Eschscholzia californica
Euphrasia nemorosa
Fragaria virginiana
Galeopsis tetrahit/G. bifida
Glechoma hederacea
Hieracium aurantiacum
Hordeum jubatum
Hypochaeris radicata

Impatiens glandulifera

Common Name
bishop's goutweed
red top

marsh meadow-foxtail
meadow foxtail
pigweed

tower rockcress
common burdock
slough-grass

field mustard

smooth brome grass
shepherd'’s purse
Siberian peashrub
perennial cornflower
mouse-ear chickweed
snow in summer
common lambsquarters
Canada thistle
narrowleaf-mountain trumpet
narrowleaf hawksbeard
orchard grass
flixweed

foxglove

Sierra shooting-star
quackgrass

redstem stork’s bill
wormseed mustard
California poppy
common eyebright
common strawberry
hempnettle

ground ivy

orange hawkweed
foxtail barley

hairy cat's ear

ornamental jewelweed
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Created 5/13/08

Taxon

Lamium album

Lappula squarrosa
Leontodon autumnalis
Lepidium densiflorum
Leucanthemum vulgare
Linaria vulgaris

Lolium perenne and similar
Lupinus polyphyllus
Lychnis chalcedonica
Malus pumila
Matricaria discoidea

Medicago lupulina

Medicago sativa ssp. falcata

Melilotus alba
Melilotus officinalis
Mentha sp.

Myosotis scorpioides
Neslia paniculata
Papaver nudicale
Papaver rhoes
Papaver somniferum
Persicaria lapathifolia
Phalaris arundinacea
Phleum pratense
Plantago major

Poa annua

Poa palustris

Poa pratensis and similar
Polygonum aviculare
Polygonum convolvulus
Polygonum cuspidatum
Potentilla norvegica
Prunus avium
Ranunculus acris
Ranunculus repens

Rheum rhabarbarum

Common Name BELA CAKR DENA

white deadnettle

European stickseed X
fall dandelion

common pepperweed X
oxeye daisy

yellow toadflax X

perennial ryegrass

bigleaf lupine X
maltesecross

apple

pineapple weed X X X
black medic

yellow alfalfa

white sweetclover X
yellow sweetclover X
mint

forget-me-not

ball mustard

Icelandic poppy

corn poppy

opium poppy

curlytop knotweed

reed canarygrass

common timothy X
common plantain X
annual bluegrass

fowl bluegrass

Kentucky bluegrass

prostrate knotweed X
black bindweed

Japanese knotweed X
Norwegian cinquefoil

sweet cherry

tall buttercup

creeping buttercup X
rhubarb

Species Detected in or around NPS unit

GAAR GLBA KATM KEFJ KLGO LACL SITK WRST YUCH Detected

X

X X X X X

X X X X X X X

X
X
X X
X X X X
X X X X
X X X
X
X
X X X X X X
X X
X
X X X
X X
X
X
X
X
X
X X X
X X X X
X X X X X
X X X
X X X X X
X X X X
X X
X
X X
X
X X
X X
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Units

1

P P Wb OO0 WL N

[ay
[

P A W R NN WNSNPRFP O ONBMNERERERERERNER®OAPEN

Mapped
Acreage

0.008
2.304

2.514
212.959
201.551

11.885
353.512

0.001

0.001
420.834

0.034

0.48
52.572

0.407

0.001

0.348

0.001
0.001
0.001

6.66
50.436
755.33

15

0.157
199.12

0.466

0.297

0.268
0.73
15.214
0.777

AKNHP
Ranking

a4

25
61
69
41

32
48
64
80
65

83
56
44
46

52
45

87

54
54
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Taxon

Rosa rugosa

Rosa sp.

Rubus idaeus
Rumex acetosella
Rumex crispus
Rumex obtusifolius
Sagina procumbens
Secale cerale
Senecio viscosus
Senecio vulgaris
Silene latifolia
Silene noctiflora
Silene vulgaris
Sonchus arvensis
Sonchus oleraceus
Sorbus aucuparia
Spergula arvensis
Stellaria media
Symphytum officinale

Tanacetum vulgare

Taraxacum officinale ssp. officinale

Thlaspi arvense

Trifolium hybridum

Trifolium pratense

Trifolium repens
Tripleurospermum maritima
Tripleurospermum perforata
Triticum aestivum

Veronica serpyllifolia and similar
Vicia cracca

Vicia sativa

Viola tricolor

Grand Total

Common Name
rugosa rose

rose

red raspberry
common sheep sorrel
curled dock

bitter dock

birdseye pearlwort
wild rye

sticky ragwort
common groundsel
bladder campion
night-blooming cockle
bladder campion
perennial sowthistle

annual sowthistle

European mountain-ash

corn spurry
common chickweed
common comfrey
common tansy
common dandelion
field pennycress
alsike clover

red clover

white clover

false mayweed

scentless false mayweed

common wheat
thyme-leaf speedwell
bird vetch

common vetch

Johnny-jump-up violet

42 - AK EPMT Protocol 2008

BELA CAKR DENA GAAR GLBA KATM KEFJ KLGO LACL SITK WRST YUCH Detected

X X X X X X

Species Detected in or around NPS unit

X

X X X X

X X X X

51

15

38

34

30

X

X X X X

31

X X X X X

a7

13

Units

2

1
1
6
4
1
1
1
1
1
1
2
1
2
1
2
3
6
1
3

=
N
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Mapped
Acreage

0.282
0.001
3.574
9.47
1.282

0.216

0.001
0.537
0.143
2.408
0.001
9.023
0.466
10.316
1.987
0.03
1235.189

211.406
16.194
375.989
0.001
1.453
22.876

0.08

0.014

AKNHP
Ranking

51
48
48

35
45
45
45
61

59
32

42/54

57
58

57
53

59

48

73



